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Welcome to FLIGHTCHECK®!
The term “flightcheck” can be simply defined as the process of checking
a document prior to printing in hopes of catching potential pro bl e m s .

All elements of the document must be precisely examined in order to preve n t
an unwanted pri n t o u t . Failing to properly and thoroughly “ f l i g h t c h e c k ” a
document could necessitate having to re t u rn to the document’s application in
o rder to make the appro p riate corrections and to then re p rint the document
all over again. For some large jobs this could add up to a tremendous amount
of wasted paper or film, lost time and consequently added expenses.

To fully understand the action of performing a proper “flightcheck” you
need only consider the comparison of what it takes to get an airp l a n e
ready for take o f f.The service engi n e e rs walk around the plane, c l i p b o a rd s
in hand, inspecting each part for its proper working condition and when
e ach item on their checklists have been checked off , then and only then
can the plane be officially approved as being “ready to fly”.

Checking out an airp l a n e, of cours e, is a far more serious activity than
the mere printing of a document because people’s lives will be at stake if
something goes wrong with the plane. On the other hand, there will no
doubt come a day when you will be asked to print an extremely import a n t
document where your job may certainly be at risk if you don’t get it ri g h t .
B u t , relax and do not wo rry! Such an event will never occur, n ow that yo u
have FlightCheck to come to the rescue and help save the day!
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Life Before FlightCheck
B e f o re FlightCheck, the most common way to check a document wa s
k n own as the “ p rint & pray ”a p p ro a c h .This is where you would print the
document, cheerfully skip over to your printer, pick up the paper, t h e n
a b ruptly bu rst into tears after spotting something wro n g .You would t h e n
h ave to go back into the document, m a ke the corrections and try pri n t i n g
again, this time with fingers crossed.

As users started getting wiser, the “ eyeball method”next became the checking
p rocess of choice.This is where you would bring up your document on
the screen and run down some sort of checklist until you happened to
notice a potential problem.Although experienced checkers would know
more about what to look for, even they would be forced to “hunt” for
p o s s i ble p ro blems by closely examining each element of the document, p a g e
by page, b ox by box , character by character.This process tended to be ve ry
time consuming, and there was no guarantee of a complete and thoro u g h j o b
eve ry time. If just one single pro blem was missed, the document would n e e d
to be re p ri n t e d .

To d ay we now have FlightCheck which scans documents electronically w i t h
high precision and speed and digs into the i n t ricate details of indiv i d u a l e l e m e n t s
and re p o rts to you its findings. In many cases, FlightCheck uncove rs potent i a l
printing problems that the human eye could not possibly ever catch.

When FlightCheck issues its final approva l , the document can then be confi-
dently sent along to be pri n t e d .B u t , the real advantage to using FlightCheck
becomes clearly evident when you consider what might happen if yo u
blindly and bravely attempt to print your document without even botheri n g
to first check it.

Therefore, before you go to press, you should always remind yourself of
this very important motto:“What you check is what you get! ”
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Installing FlightCheck

System Requirements
To use FlightCheck, you will need the following hardware:

• A Macintosh computer with either a 68K or PPC processor.

• A minimum of 4 to 8 MBs of RAM.

• Apple System software version 7.5 or higher.

• 13” RGB monitor.

Installation Procedure
To install FlightCheck, simply double-click the FlightCheck Installer icon
on your master diskette and choose the destination for the station where yo u
will be using your FlightCheck.

Memory Configuration
FlightCheck only requires about 4 MBs of RAM to operate sufficiently
upon average to medium size jobs. H oweve r, if you want to check ve ry large
files, or use a Fonts Database (as explained on page 24) which references
a large quantity of fonts, you will need to increase FlightCheck’s memory.

To increase the amount of memory allocated to FlightCheck, click once
on the FlightCheck application icon, then select “Get Info... ” from the
F i n d e r ’s File menu .The Get Info window will appear, d i s p l aying a va riety o f
i n f o rmation about the application. In the lower right corner of the window
is the Memory Requirements are a .This lists the Suggested, M i n i mum and
Preferred memory settings.

Enter a new value for the Preferred size. 8 MBs is usually plenty to run
FlightCheck on fairly large jobs.

Serial Number
Upon initally launching FlightCheck yo u
will be asked to enter your s e r ial n u m b e r .
You can find the serial number on the back
of the diskette or on the re gistration card .

Please take the time to fill out the re gistration card and re t u rn it for a
special FlightCheck T- s h i rt! Re m e m b e r, only officially re gi s t e red users are
eligible for free Tech Support and update notifications.
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FlightCheck Preferences
When you first launch FlightCheck, a folder will be created within yo u r
S y s t e m->P re f e rences folder called “F L I G H T C H E C K® P refs ƒ”.This folder
will contain your F L I G H T C H E C K ® P re f e re n c e s file as well as the Fo n t s
Database file (page 24).The Pre f e rences file holds va rious setup parameters ,
such as the positions of windows, your current sets of Ground Controls
(page 38), and so fort h .You may trash the F L I G H T C H E C K® P re f e re n c e s
file or the Fonts Database file at any time prior to running FlightCheck
and a new F L I G H T C H E C K® Preferences file or Fonts Database file will be
automatically created.

Setting A Password
FlightCheck allows you to set your own passwo rd in order to prevent others
from running your copy of FlightCheck, effectively stopping them from
c h a n ging your particular setup or pre f e rences settings.You can set a passwo rd
by selecting “Set Pass word... ” from the Edit menu.

To create a passwo rd , click the Set
Pa s swo rd bu t t o n . If a passwo rd
already exists, first enter the pass-
word before clicking the button.

Enter your passwo rd (up to 8 char-
a c t e rs ) and click OK upon which
you will be asked to retype yo u r
password for verification.

Thereafter, whenever you launch
FlightCheck you will be asked to enter your password to continue.
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FlightChecking a Document

Selecting a Document
Locate the document
you wish to flightcheck
by first selecting “O p e n
D o c u m e n t . . . ” f ro m
the File menu .

You can choose which
file types to view by
selecting the desire d
c h e c k b oxe s . D e t a i l e d
information about the
currently selected file

will be displayed on the left, such as its file type and ve rsion nu m b e r, t h e
file’s creation and last modified dates and the file’s size on disk.The doc-
ument’s page size will be presented on the right side of the window, as
well as a preview of the document (if one exists).When ready, click the
“ O p e n ” button or double-click the document’s title on the list.

Note that you can check multiple documents by dragging their icons (or
the folder they reside in) onto the FlightCheck application icon and they
will be examined individually one by one. (If drag & drop does not wo r k
properly for you, then you will need to rebuild your desktop).

Recent Files
Upon opening a document, its name will be conveniently placed on the
“Recent Files ” pop-up menu under the File menu .This allows you to
examine the file at any time in the future by simply selecting it from the menu .
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FlightCheck Tip:
Use the Find... button to searc h
the current volume in order to
locate a document by name.

FlightCheck Tip:
Holding down the control key
while clicking a checkbox will
automatically deselect all other
checkboxes.

FlightCheck Tip:
To remove an item from the menu,
select it while holding down the
shift key.



Scanning a Document
When a document has been selected and
o p e n e d , FlightCheck will then begin scan-
ning the file by examining its elements and
building lists of data, such as the colors ,f o n t s
and images used by the document and placed
a rt wo r k .While this is occurri n g , a window
will appear informing you of the progre s s .

You can abort the process at any time by pressing c o m m a n d + “ .” ( p e ri o d ).

Examining a Document
FlightCheck will perform an extensive examination of the document and
all its elements. It will look at each page of the document and examine
all of the boxes and objects and re c o rd the va rious attri butes and parameters
regarding each box, such as its position on the page, its background fill
c o l o r, its frame color and thickness, and so fort h . FlightCheck will also
scan the text characters of each story and re c o rd their font and style usage,
then determine the locations of the font suitcases and printer font files
and further scan these files to obtain additional detailed information about
each font used. FlightCheck will likewise investigate each of the source
image files by locating their links, opening the image files and scanning
t h rough their internal data to obtain more information about each image,
such as its re s o l u t i o n , color mode, and so on.A d d i t i o n a l l y, F l i g h t C h e c k
will begin gathering other important information about the document
such as its printer settings, trapping defa u l t s , style sheets and typogr a p h i c a l
p re f e re n c e s ,e t c. FlightCheck will even conduct further re s e a rch if it detects
and determines the document has re l a t e d ,p o s s i bly even re q u i red files, s u c h
as XTensions, Preferences, Libraries, Dictionaries, P P Ds, etc.

Verifying a Document
Once the document has been fully examined, a verification process will
b e gi n .The gathered data is compared to a set of user-definable rules (know n
as the “Ground Controls”) which allows you to instruct FlightCheck to
d e t e rmine what exactly constitutes a passing or failing gr a d e. F i n a l l y, w h e n a l l
of the tests have been completed, FlightCheck will display a Results window
and present to you a compre h e n s ive and detailed re p o rt of the analysis.
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FlightCheck Results

Results Window

After FlightCheck scans a document, the Results window will appear.

At the top of the Results window are the eight basic categories for which
FlightCheck will re p o rt .A green “ √ ” checkmark means the category appears
to be OK while a red “X” means the category did not pass the tests.The
specific pass or fail status of each category depends, of cours e, upon the
current Ground Controls settings, as explained later.

Flagged Items
The Results window will display a list of flagged items, in other words
potential problems. Single-click a line and additional helpful infomation
about the item will be displayed at the very bottom of the window.

Specific Items
Click any arrow on the left side of the Results window to open an item
(or simply double-click the row) to reveal the specific elements involved.

Select the “S h o w All Specific Items ” c h e c k b ox to reveal or hide all items
(or hold down the option key while clicking an arrow).

FlightCheck Tip:
Double-click the eagle icon at the
upper left corner to perform a full
FlightCheck at any time.

FlightCheck Tip:
Hold down the control key while
double-clicking an image name to
select the image on the Main win-
dow. Include the command key to
be taken directly to the Problems
Layout window.



Possible Remedies
To the right of each item on the Results list will be displayed a possible
remedy for the potential pro bl e m .These simple solutions can often be used
to help you quickly figure out how to correct the problem.

TrueFile™ Solutions
D o u ble-click on any possible re m e d y, or select a possible remedy and click
on the Tru e F i l e ™ S o l u t i o n s button at the top right corner of the Re s u l t s
window, and the TrueFile™ Solutions window will appear.

The Tru e F i l e™

Solutions window
gives you more in
depth information
about the potential
p ro bl e m , the possibl e
remedy and how to
implement a solution.

Print Results
You can print the Results (when the Results window is frontmost) by
selecting “Print Results... ” from the File menu at which time you can
choose to include the Remedies, as well as the type of font you wa n t
for the printout.

Save Results
You can save the Results to a text file, allowing you to import the text
file into an editor, by selecting “Save Results... ” from the File menu.

Sound Alert
When checking is complete and FlightCheck has detected some sort of
p ro bl e m , an “eagle cry ” a l e rt will sound.This can be turned off by selecting
“Turn Off Sound Aler t” under the FlightCheck® menu.
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FlightCheck Tip:
You can find the FlightCheck Fonts
menu for OS 8 under the General
popup menu.

FlightCheck Tip:
You can copy text by dragging and
highlighting it and pressing com-
mand+C, after which you can
close the window and paste the
text into an editor by pressing
command+V.

S e c ret Tip: Hold down the
control key while selecting “Sound
Alert” to choose a sound file.
Use the command key to revert
to the eagle cry.



FlightCheck Main Window

Main Window
The FlightCheck Main window contains six category buttons which
you can use to reveal all the details of the current document.

Application Link Button

The Application Link button will display the name and ve rsion number of
the application which created the document. If the application location is
u n k n ow n , as evidenced by the Application Link button data being displaye d
in re d , or a red “ X ” a p p e a rs to the left of the bu t t o n , then FlightCheck
will be unable to employ certain advanced functions.

Selecting the Application

The first step you will need to take is to locate and select the application
that created the document.This is done by either single-clicking the
Application Link button, or by selecting “Locate Application... ” from
the FlightCheck® menu.

FlightCheck will display a list of all possible applications that might have
c reated the document. Select the appro p riate application ve rsion by clicking
once on its name to highlight it, then click the “S e l e c t ” bu t t o n .F l i g h t C h e c k
will then be able to update the display of the Application Link bu t t o n , a s
well as other related areas such as the Printer Type and Print Info boxe s
on the Main window.
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FlightCheck Tip:
Double-click the eagle icon at the
upper left corner to perform a full
FlightCheck at any time.

FlightCheck Tip:
Hold down the control key when
using the Application Link button to
avoid searching Network volumes.



Applications Locations
As you work with va rious types of documents, FlightCheck will re m e m b e r
the locations of your major applications such as QuarkXPre s s , Pa g e M a ke r,
FreeHand, Photoshop, Illustrator, etc., and will automatically select them
for you whenever you open a document created by one of them.

It is important to keep in mind that the application version you used to
create a document should be the same as the one you intend to use to
p rint the document. For this re a s o n , if you are going to a Service Bure a u ,
it is always advised you own a copy of the same application they will be
using, otherwise the output may not be quite what you expect. However,
it is sometimes acceptable to use a different minor revision number of an
application (generally recognized as the second digit). For example, an
application ve rsion of 1.02 might be equivalent with re g a rds to the pri n t i n g
output to a version 1.01, whereas the application versions 1.0 and a 1.1
(their first digits differ) might be totally different with respect to the way text
is flowe d , and the va rying pre f e rences for each ve rsion of the application might
also affect pri n t i n g .

Launching the Document
Once an application
has been located, you
can thereafter launch it
at any time by single-
clicking the Application
Link button, or by

selecting “Launch Document... ” from the FlightCheck® menu.

At this time you can also select the “Launch document ” checkbox to
send along a request to the application to open the current document.

You may work on the current document inside its application as desire d , bu t
keep in mind that any changes you make to the “ l ive ” document will only
be in memory and there f o re FlightCheck will be incapable of re c og n i z i n g
your changes to the document. H oweve r, once you save the document
and then re t u rn back to FlightCheck, the document file will be re s c a n n e d
in order to update all the data to the document’s currently saved state.
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Printer Type Button
The Printer Type button will display the name of the Printer that has
been selected according to the document’s internal Print record.This
name is commonly the same as the PPD chosen from the application’s
Page Setup window.When the Printer Type name appears in red,then
either the application could not be located or the specific Printing
device could not be found.

To obtain more detailed information about the Printer Type simply click
on the bu t t o n .

The Printer Type Info window will appear giving you additional data
regarding the output device.

This information includes the resolution, paper size, data format, halftone
s c re e n , paper offset, paper width, page gap and halftone angles (if know n ) .
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The 6 Category Buttons
You can click any one of the six category buttons at any time to expand
the window to reveal details regarding the category.

Reclick the button to collapse the window and close up the category.

Resizing a List
You can resize the lists for the colors , fonts or images categories by draggi n g

the are a ’s grow box at the right side of the window.The entire window
can be resized by dragging the grow box at the window ’s bottom right cor-
n e r, or by clicking the zoom box at the upper right corn e r, in which case
all categories will be automatically adjusted in size.

Show/Hide Detailed Usage
You can hide the details of the status and usage icons for the colors , f o n t s
and images categories by selecting “Hide Detailed Usage ” f rom the V i ew s
m e nu , or by pressing command+Y. Reselect the menu item to again show
the details.
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FlightCheck Tip:
Hold down the control key when
clicking a button to also close all
other categories. Include the option
key to open or close either the left
or right group of 3 buttons, or include
both the option and command
keys to open or close all buttons.



File Info
Click the File Info button to reveal the File info section.

The File Info area will display the version number of the document,
along with the file’s creation and last modified dates, and its file size.

Version
If the document’s version number appears in red, then FlightCheck is
i n f o rming you that the document ve rsion is different than the curre n t l y
selected application’s version number.This is obviously important because
if you we re to use the wrong application to print a document, the text
could certainly flow differently and cause an unwanted printout.

Language
A letter displayed after the document’s ve rsion number will indicate the
c o u n t ry or l a n g u a g e of the document. For example, a ve rsion nu m b e r
“ 1 . 0 - G ” will signify a German document.The letter “ M ” will mean the
document uses multiple languages.The document’s language is useful to
k n ow for it could be a forewa rning of a possible text flow pro bl e m ,e s p e c i a l l y
if the currently selected application bases its hyphenation and justification
rules on some other language.

Required XTs
For QuarkXPress documents, a list of XTensions which may have been
used to build the document will be displayed on the Main window.

Click the list to reveal the Required
XTs window.An “*” asterisk will sig-
nify the XTension will be required,
otherwise it is merely suggested you
include the XT during Collect.The
checkmarks designate which XTs yo u
want to collect (page 64).
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Page Info
Click the Page Info button to reveal the Page Info section.

The Page Info area will display the document’s page width and height, t h e
paper width (if know n ) , the number of pages and spreads contained in the
d o c u m e n t , and the starting page nu m b e r.

Page Width and Height
The page width and height will be displayed using the units selected
under the Edit ->Measurements pop-up menu. If either page dimension
appears in red then this means FlightCheck is warning you that the doc-
ument size is not within the boundaries of the paper size according to the
document’s Print record. Sometimes an overriding value entered into a
P P D (usually through the application’s Page Setup window) may cause
a conflict where the document cannot be printed within the selected paper
size area and this will cause each printed page to be “clipped”.

Number of Pages
The total count of the number of pages used in the document will be
displayed.

Number of Spreads
The total number of spr e a d s will be based upon a calculation that will
tally the number of spreads which contain at least 2 pages. In other wo rd s ,
spreads that have only single pages will be ignored in this total.

Starting Page
The actual s t a r ting page n u m b e r of the ve ry first page in the document
will be give n . If the starting page is using a special Section Fo rm a t , f o r
example you started page numbering at 100, then an “*” asterisk will be
displayed to inform you of this fact.
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Print Info
Click the Print Info button to reveal the Print Info section.

The Print Info area will display the document’s Print parameters based
on the settings originally chosen in the application’s Page Setup window
including the print re s o l u t i o n , line scre e n i n g , the output quality, data form a t ,
if separations or spreads have been turned on, re gistration or printer marks
setting and bleed va l u e.A d d i t i o n a l l y, the Print Info area will indicate whether
or not the document is to be printed in color or black & white, if there will
be a reduction or enlargment scaling, as well as the orientation and paper
size (if know n ) . If any of the Print Info items appear in re d , then FlightCheck
has determined that there is some sort of pro bl e m .

Resolution
The output r e s o l u t i o n ( d i s p l ayed in dots per inch) will be obtained fro m
the document’s Print re c o rd . In some cases you may consider the re s o l u t i o n
value to be a mere “ re c o m m e n d a t i o n ” to the final output dev i c e, as it may
not yet be determined if the device is capable of outputting at the re q u e s t e d
re s o l u t i o n , but more import a n t l y, the output resolution can often be manu a l l y
changed at print time.T h e re f o re, FlightCheck will usually ignore this va l u e
and will post no resolution error (unless the value is unknown).

Line Screen
The line screen value (displayed in lines per inch) is obtained from the
document’s Print record (but can be overridden by the P P D).The line
s c re e n , also known as screen ruling or screen fre q u e n c y, re f e rs to the nu m b e r
of rows or lines of dots used to render an image on film or paper.The
relationship between the output resolution (dpi) and the screen ruling (lpi)
d e t e rmines how fine or coarse a bitmap image appears on the pri n t e d
output.The screen ruling to employ depends on the resolution of the
i m a g e s e t t e r, the paper stock and the type of press used to print the publ i-
c a t i o n .A new s p a p e r, for example, is commonly printed using a low scre e n
ruling of about 85 lpi because of the paper stock’s high absorbency of
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FlightCheck Tip:
FlightCheck will compare the res-
olution of each image to the line
screen value in order to determine if
the image can be acceptably printed.



ink and the high speed of the pre s s . A higher screen ruling would saturate
the newsprint with ink and make the images look muddy. On the other
h a n d , a four-color magazine printed on coated paper might use a scre e n
ruling of 133 lpi.A lower screen ruling would make the images coars e
and less detailed.

Output
The o u t p u t type chosen for the document will be displayed as either
Normal, Low Resolution or Rough. Sometimes there is a need to print
a low quality or quick proof ve rsion of a document, and some applications
even allow printing images as gr ay boxes in order to save time. B u t ,s h o u l d
you forget to change the Output setting back to Norm a l , F l i g h t C h e c k
can be depended upon to remind you.

Data Format
The data format for printing the document, either A S C I I or Binary,
will be displayed.The data format refers to how data (such as the pixels
of an image) should be sent to the output device. Some output devices
can only accept A S C I I d a t a , w h e reas sending A S C I Idata to an output
device which is capable of handling Binary data might simply increase
the amount of time it takes to print the job.

Separation
The separation setting for printing the document will be displayed as
either On or Off .

Spreads
The status for printing spreads , either On or Off , will be displayed.

Registration Marks
If print reg istration marks has been turned on for the document, the
words “Centered”or “Off Center” will be displayed, followed by the off-
set value (if known), otherwise the word “Off ” will be displayed.
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FlightCheck Tip:
If you are checking a live Quark-
XPress document, click on the
Registration box to update the
current offset value.



Bleed
The bleed value (if known) will be displayed.This value represents the
amount of distance an object should be extended beyond the edge of the
page in order to account for any misregistration when cutting the paper.

Print 
The color printing type , either Color, C o l o rs to Gray or Black & W h i t e,
will be displayed. Often one might print a quick draft of the document
by selecting Black & W h i t e, then forget to change this back to Color when
going for a final output, in which case FlightCheck will be able to alert
you of this fact.

Scale
The scaling f a c t o r , Enlarge or Reduce, which has been set for printing will
be displaye d .M a ny times one may not have an in-house imagesetter capabl e
of wide printing, and therefore one might elect to reduce the printout to
have it “fit” on a Laser printer, but fail to remember to readjust the scale
factor back to 100% before the final output, and this is the type of obv i o u s
mistake FlightCheck can be counted on to remind you about.

Orientation
The orientation for printing the document, either Portrait (upright) or
Landscape (sideways),will be displayed.

Paper Size
The paper size (if known) which has been selected for printing will be
displayed.
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Colors List
Click the Color s button to reveal the Colors Info section.

The Colors Info area will display a list of the colors used in the document
or within placed images. FlightCheck builds this list by examining the colors
used for text characters , the colors which have been applied to the backgro u n d
fills and frames of boxe s , the colors used for lines and paragraph ru l e s , and the
c o l o rs re f e renced within placed images.

The icons on the right portion of the Colors list will re p resent how the
c o l o rs are used within the document, including whether or not a color has
been applied to text, a box fill or frame, a line or ru l e, or if colors have been
set for va rious types of trapping. Icons which appear in red mean FlightCheck
has determined some sort of problem exists with the color based upon
the related Ground Controls settings.

Color Type Icon

The first column on the left, under the Usage section, shows an icon
which informs you of the color’s basic type.

Icon Meaning

The 4 Process colors, Cyan, Magenta, Yellow and Black , will
be recognizably displayed using their respective colors.

The P r ocess color icon means that during the pri n t i n g , the color’s
CMYK values will be used and no separation plates can be obtained
based on this specific color.

The Spot color (green icon) means when printing separations
you can use this specific color for an additional plate.

The R egi s t r a t i o n icon signifies the special re gistration color which
is most often intended to be used to print registration marks and
targets which will appear on all plates.
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Used in Document Icon

The second column document icon informs you whether or
not the color is being used in the document.When this icon
appears in this column, it tells you that the specific color is used
somewhere in the document in a text story, as a background fill,
in a blend or gradient, or for a frame or line or paragraph rule.

Used in Image Icon

The third column imag e icon informs you whether or not the
color is being used in an image. In EPSF i m a g e s , the color usually
pertains to a painted or stroked object making up the drawing,
and is often listed as a Spot color. A detailed T I F F i m a g e, which can
have millions of colors, is most often determined to consist of
m i x t u res of the 4 process colors :C ya n ,M a g e n t a ,Ye l l ow and Black.

Color Name and Sample

To the left of each color’s name is a sample display of the color.
Note that an underlined name indicates the color is a Spot color,
an italicized name indicates the Spot color is unused and an out-
line name indicates a mismatch (the color values defined in the
application are differentl than the values in a placed EPSF).

Color Model, CMYK Values and Angle
To the right of the color’s
name are columns giv i n g
you the color model, t h e

actual C M Y K values and the color’s screen angle.Values displayed in their
re s p e c t ive C M Y K c o l o rs indicate the color is a Process color while va l u e s
displayed in black indicate the color is a Spot color.A red value means the
color is invo l ved in some sort of “ m i s m a t c h ” (the color is defined differ-
ently within an image).The Angle value indicates the angle at which the
color will be printed upon final output.

19

COLORS LIST

FlightCheck Tip:
Click and hold the button on the
image icon to view a menu of the
images using the color. Select an
item to likewise select the image
on the Images list.



Color Usage Icons
The icons at the right side of the Colors list re p resent how the color is
being used in the document.A black icon will indicate the color has been
applied to an object defined by the column header.A red icon will mean
FlightCheck has also determined the color usage to be some sort of “ e rro r ” .

Icon Meaning

The text icon means the color is being used in a text story.

The text box fill icon means the color is being used as the
background for a text box.

The picture box fill icon means the color is being used as the
background for a picture box.

The blend icon means the color is used as the starting or ending
color of a blend.

The text box frame icon means the color is being used for a
text box frame or border.

The picture box frame icon means the color is being used for
a picture box frame or border.

The line icon means the color is used in a line.A thin line will
denote a hairline.

The rule icon means the color is being used for a paragraph
rule.A centered line will denote a hairline rule.

The default trap icon means a default trapping value has been
set for the color.

The fill trap icon means the color has a trapping value set for
colors used in background fills.

The frame trap icon means the color has a trapping value set
for colors used in frames or borders.

20

FLIGHTCHECK



Color Info Window
You can double-click a color name on the Colors list to view additional
information regarding that particular color.

When the Colors Info window is on the scre e n , you may thereafter single-
click any other color on the Colors list to obtain the color’s info.

Trap Info Window
To view the default trapping values of the document’s colors, select
“Show Trap Info ” from the Views menu, or press command+T.

The Trap Info window will display a list of those colors which have back-
ground trapping values defined. Click to select a color on the top list and
the trap specifications for its defined background colors will be listed at the
bottom of the window.

Trapping is a printing term used to describe the solution to a specific pri n t i n g
p ro bl e m .This occurs when two or more colored objects overlap and cause
m i s re gistration due to the physical pro blem of lining up of separate plates,
not to mention the ink absorption rate of the type of paper used.T h e
solution is to expand or shrink a particular object (also known as “ s p re a d i n g ”
or “choking”) to compensate for the physical inaccuracies.
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Fonts List
Click the Fonts button to reveal the Fonts Info section.

The Fonts area will display a list of the fonts used in the document or by
placed images. FlightCheck forms this list by examining the text characters
used in each story, and scanning all EPSF images for their re f e rences to fonts.
A ny item on the Fonts list which appears in red means FlightCheck has deter-
mined some sort of pro blem exists based on the Grounds Contro l s.

Font Status Icons
The 5 columns under the Status section will display va rious icons inform i n g
you of the status and usage of each font.

Icon Meaning

The S y s t e m icon informs you that the font is currently active.
A red icon indicates the font is inactive or cannot be located.

The fonts database icon means the font is not currently active,
but can be found in the Fonts Database.

The embedded font icon means the font resides inside the
E P S F, Postscript or P D F file being checked.

The font file icon represents the suitcase file in which the font
resides.A red icon indicates the suitcase file cannot be found.

The printer font file icon represents the font’s printer file.A
red icon indicates the printer file cannot be found.A “-” dash
character means a printer font will not be required for printing
(TrueType™ fonts).

The document icon means the font is used in a text story
somewhere within the document.

The imag e icon means the font is referenced in an E P S F image.
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FlightCheck Tip:
Click and hold the button on the
image icon to view a menu of the
images using the font. Select an
item to likewise select the image
on the Images list.

FlightCheck Tip:
Hold down the command key
while double-clicking a font on the
list to go to the Fonts Database.



Font Name
This column will display the name of the font. If a name is displayed
in red then this indicates FlightCheck has detected some sort of pro bl e m
regarding this font in general.

Printer Font Filename
This column will display the p r inter font filename .A “ - ” dash character
means a printer font will not be re q u i red for printing (Tru e Ty p e™ f o n t s ) .
A red name means the file cannot be located. P rinting a document when a
p rinter font file is missing will usually result in a completely unwanted or
unexpected printout as the font will most likely be substituted (commonly
with the dreaded font “C o u r i e r ”).

Font Style
The S t y l e column will inform you if a style has been applied to the font.
Some fonts have built-in styled ve rs i o n s , which usually print just fine, but in
o t h e r cases where the font has no equivalent style, FlightCheck will consider
t h e usage of such a typeface to be an “error”.

Font Type/Version/Manufacturer
These columns will inform you of the font’s t y p e , such as Type 1,Tru e Ty p e™,
Multiple Masters (“MM”), etc., as well as the font’s version number (if
known) and the name of the manufacturer of the font (also if known).

Font Info Window
You can double-click a font name on the list to view additional inform a t i o n
regarding that particular font.

Note that when the Font Info window is on the screen you can simply
single-click another font on the list to view its info.
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Use Fonts Database

The Use Fonts Data b a s e c h e c k b ox instru c t s
FlightCheck to look into the Fonts Database for a font whenever it appears
to be missing or is not currently active at the time of the examination.

Fonts Database
FlightCheck offers a very valuable feature called the “Fonts Database ”.
To view the Fonts Database, select the item from the FlightCheck® menu,
or press command+D.

The Fonts Database is a list of the source folders where you would like
FlightCheck to look in order to find missing fonts, which thereby allows
FlightCheck to examine and verify fonts, as well as collect them, even if
the fonts are not active.

Fonts Folders
The Fonts Database works by allowing you to inform FlightCheck of the
locations of the va rious folders containing your font files.A Fonts Folder can
be added to the list by clicking the “Add Folder ” button and a window
will appear asking you to select the desired folder. N ow you may also dire c t
FlightCheck to include all nested folders within the chosen parent folder.

Screen Fonts
On the left portion of the Fonts Database window will be the list of s c re e n
f o n t s which consists of the names of the font as you would see them if yo u
we re inside your application working on the document. An u n d e r l i n e d
name indicates the font is currently active.
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FlightCheck Tip:
Use the “Allow loose Printer Fonts”
checkbox to search all font folders
for missing printer files (a feature
of Suitcase). Note that this may
slow down the Fonts Database.

FlightCheck Tip:
You can type in a partial name for
a screen font in order to find and
select it on the list.



Font Suitcases
When you click on a screen font name, its associated Font Suitcase on the
right portion of the screen will likewise become highlighted.

On the right side of the window will be a list of the Font Suitcase files in
which the fonts reside on disk. Click on the arrow to the left of a suitcase name

to “ o p e n ” the suitcase and
reveal the fonts, along with
the names of their re s p e c t ive
styles and printer font files.

To remove a suitcase (provided it contains no active fonts),select it on
the list and click on the Remove Suitcase button.

Style
This column will display the respective style for the given font. It is
i m p o rtant to note that if a particular style (plain, b o l d , italic or bold+italic)
is not listed, then this means the font cannot support the style.

Printer Font Files
When a font suitcase item is “ o p e n ” and its contents are reve a l e d , the font’s
p r inter file name will also be displaye d .A red icon indicates the file
cannot be found, while a “ - ” dash will mean the printer font file will not
be required for printing (for TrueType™ fonts).

Active Fonts
The A c t i ve Fo n t s radio button allows you to display a list of the fonts which
a re currently active in your System.

All Fonts
The All Fonts radio button can be selected to alternatively view a list of
all fonts contained in your Fonts Database.
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FlightCheck Tip:
Hold down the option key while
clicking the twist down triangle to
open or close all suitcases.

FlightCheck Tip:
You can tell if a font supports a
particular style by examining the
suitcase in the Fonts Database. If
the style is not listed, or the printer
font file is displayed in red, then
you will know there could be prob-
lems printing the style.



Images List
Click the Images button to reveal the Images Info section.

The Images Info area will display a list of the images used in the document.
FlightCheck will locate the link to each source image file and scan its
i n t e rnal data or characteristics to obtain the detailed information to display
on the Images list.

Image Usage Icons
The icons at the left side of the Images list will represent the status and
usage of the image file, whether or not the image’s creator exists, and if the
image is re f e rencing fonts (EPSF) , and the right portion of the Images list
will re p resent the attri butes of the images within the document, including
whether or not an image has been scaled, s kewed or ro t a t e d , or if the box
it resides in has been scaled, skewed or rotated, or if some “style” or col-
orization has been applied to the image. Icons which appear in red mean
FlightCheck has determined some sort of problem exists with the image
usage based upon the related Ground Controls settings.

Icon Meaning

The i m a g e icon will be displayed based on the known application
which created the image.

The f o n t icon will re p resent the fact that the EPSF image is re f e r-
encing one or more fonts.A red icon will indicate that FlightCheck
has also detected something wrong with at least one of the fonts.
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FlightCheck Tip:
Click and hold down the button on
the “font” icon to view a menu of
the fonts used by the image.
Select an item to likewise select
the font on the Fonts list.

FlightCheck Tip:
Click and hold down the button on
the image icon to view a menu of
the colors used by the image.
Select an item to likewise select
the color on the Colors list.

FlightCheck Tip:
Hold down the command key
while double-clicking a problem
image on the list to go straight to
the Problems layout.



Image Name 

The image name will be displayed under the Name column.Additional
characters or marks may appear next to the name.

Mark Meaning

The image contains other embedded images. Click the ar row to
reveal them.

+ The image is stored within the document or within another image.

- The image is not included in the document, but is merely refer-
enced by pathname.

The image is down-sampled F P O (For Position Only).

The image is hi-resolution O P I.

Page
The Pa g e column will display the page number on which the image can
be found in the document.An “ * ”a s t e risk indicates the page number is the
s t a rt of a re nu m b e ring or Section Fo rm a t .A “ ‡ ” character preceding the
page number indicates the image is positioned entirely off the page. For
Pa g e M a ke r® d o c u m e n t s ,“ † P B ” will signify the image is on the pasteboard
area of the document.

Status
The Status column will display the status of the image file:

Status Meaning
OK Image file exists.
Missing Image file cannot be found.
Modified Image file has been changed (last saved date is different).
Off Page Image is outside the printable area.
Non-Print Image is suppressed from printing.
Stored Image is embedded in the document file.
Nested Image is embedded within another image.
L Z W Image is L Z W encoded.
J P E G Image is J P E G encoded
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FlightCheck Tip:
Click on the word “Name” to tog-
gle showing the images using
their full pathname.

FlightCheck Tip:
Click on the word “Page” to toggle
showing the page numbers in
Section Format “*”.



Size
The S i z e column will display the image’s physical file size (which will also
be used later on to estimate the disk space re q u i red to Collect the image).

Type
The Type column will display one of the following image types:

Type Description
P I C T 72 dpi Macintosh picture
T I F F Tagged Image File Format
E P S F Encapsulated Postscript File (vector drawing)
E P S Encapsulated Postscript (pixel based image)
D C S / D C S 2 Desktop Color Separations
C T Scitex Continuous Tone
L I N E Scitex Line Work
J P E G Joint Photographic Experts Group (compressed)
P D F Acrobat® Portable Document File

Mode
The Mode column will display the image mode using one of the follow i n g :

Type Description
1 - B I T Black and white
M O N O Monotone
D U O Duotone
T R I Tritone
QUA D Quadtone
G R AY Grayscale
I N D E X Indexed (1 byte index into an RGB color table)
RG B 3 bytes: Red, Green, Blue
C M Y K 4 bytes:Cyan, Magenta,Yellow, Black
L A B Lab Color
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FlightCheck Tip:
A number after the mode indicates
the image contains extra channels.
An underlined mode indicates the
image is comprised of layers.

FlightCheck Tip:
An underlined size value means
the image has been compressed
(such as LZW or JPEG).

FlightCheck Tip:

The icon indicates the image
is an IBMPC type image.



DPI
The DPI column will display the resolution of the image in terms of dots
per inch. Note that you can click on the “D P I” column header to tog g l e
v i ewing image resolutions by DPC (dots per centimeter).An EPSF ( ve c t o r-
based) image will show “ n / a ” (not applicable) for its DPI because by nature
an EPSF is comprised of Po s t S c ript drawing commands which can be
acceptably printed within any spatial area or output resolution.

X% / Y%
The X % and Y % columns will display the horizontal and ve rtical scaling
fa c t o rs that have been applied to the image. Both too high or too low scaling
factors will effect image quality and RIP time.

Effective Resolution
The R e s . column will display the Effective Resolution of the image.
This is the result of multiplying the image D P I times the Y% scale factor.
The ve rtical scale factor is used in the equation because this value can later
be compared to the output lines per inch screening value.

Image Attributes Icons
The icons at the right side of the Images list re p resent the a t t ri bu t e s t h a t
h ave been applied to the picture box .A black icon will signify the attri bu t e
defined by the column header has been applied to the picture or the picture
b ox .A red icon will signify FlightCheck has detected some sort of “error”
regarding the attribute according to the Ground Controls.

Icon Meaning

The “None” backg round icon signifies that the picture back-
ground has been set to the special transparency color called “ N o n e ” .
Several problems can arise when an image is printed containing
white around its edges.When the pixels are transferred to the
p rinted page the white pixels will literally paint over and essentially
erase the destination are a .The application must there f o re create a
special “clip are a ” when drawing the image to prevent the erasure.
H oweve r, the calculations to perform this clipping can be of such
l ow quality that the edges of the image may appear to be “ j a g g e d ”
when printed.
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FlightCheck Tip:
Click on the word “DPI” to toggle
showing the resolution using DPI
(dots per inch) or DPC (dots per
centimeter).



Icon Meaning

The clipping path icon will re p resent the fact that the image
contains Po s t S c ript commands that will clip the image causing
only certain portions of the image to be pri n t a bl e. Note that if
the background of the picture box has been set to “ N o n e ” , f o r
a transparent effect, a clipping path is usually re q u i red for a pixe l
based image, otherwise the edges will print “ j a g g e d ” . If the needed
clipping path is missing, this icon will be displayed in re d .

The picture box frame icon will indicate that the picture box
contains a frame or bord e r. If the frame is a custom bord e r, t h e n
FlightCheck will usually flag this as an “ e rro r ” because such frames
a re usually “ b i t m a p ” ( t h ey should be Po s t S c ript drawings instead)
and will not print very well.

The p i c t u r e box rotation and skew icons will indicate that the
picture box itself has been rotated or skewed.

The contents flip icons will indicate that the contents of the picture
box has been flipped horizontally or vertically.

The i m a g e r o t a t i o n icon indicates that the picture inside the picture
b ox has been ro t a t e d . It is usually considered a better practice to alway s
rotate an image within the application that created it, mostly to save
processing time, allowing you to place the image on the document
page straight up.

The image sk ew icon indicates that a skew has been applied to
the picture inside the picture box.

The Style or Image Contr o l icon indicates that a Style or Contrast
has been applied to the image. FlightCheck usually considers any Style
to be an “ e rro r ” because some pri n t e rs cannot handle the stylization
commands, or literally throw out the information when substitut-
ing with a hi-res image.

These icons indicate that the image contains a Halftone Screen
or a non-linear Transfer Function , or both.
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Image Preview Window

You can double-click an image name on the list at any time and the
I m a g e Pre v i e w w i n d ow will appear. Note that when the Image Prev i ew
w i n d ow is on the screen you can simply single-click another image on the
list to view its info.

The Image Prev i ew window will also show you the colors and fonts used by the
i m a g e, as well as any Styles or Contrasts that may have been applied to the image.

Find Creator
Click the Find Creator button to locate and launch the application
which created the image.

F l i g h t C h e c k
will display a
list of possibl e
a p p l i c a t i o n s
that could have
c reated the
image. Select

the desired application and click the “Launch” button to activate it. If yo u
would also like to have the application open the image, select the “Launch
imag e” checkbox just prior to clicking OK.
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FlightCheck Tip:
Hold down the control key when
clicking the Find Creator button to
avoid searching Network volumes.



Find Image
If the image is missing
you can attempt to locate
it by clicking the Find
I m a g e bu t t o n . At this
time you may also elect
to automatically update
other images that reside
in the same folder as the
newly found image.

Alphabetical Images List
To view document images alphabetically, select “Alphabetical Imag e
List... ” from the Views menu or type command+;.

Click the Print button to p rint the list of alphabetical images.

32

FLIGHTCHECK

FlightCheck Tip:
Hold down the control key while
double-clicking an image name to
go to the Image Preview window.
Include the command key to go to
the Problems Layout.

FlightCheck Tip:
Double-clicking an image name
will select the image on the
Images list of the Main window.

FlightCheck Tip:
The “Find...” button will conve-
niently contain the image name.



FlightCheckViews
FlightCheck allows you to view the data lists on the Main window seve r a l
different ways through the use of the Views palette.

Show/Hide Views Palette
Activate the Views palette by selecting “Show Views Palette ” from the
Views menu, or by pressing command+H.

The V i e ws palette a l l ows you to pick and choose
h ow you would like to view the lists of colors ,f o n t s
and images. By clicking on the desired “ p ro bl e m ”
bu t t o n s , you can selectively obtain lists of the offend-
ing elements. For example, to instantly see which
fonts are currently active in your System, click the
“Active Fonts” button within the Fonts area of
the palette.The Main window will then re d i s p l ay
the fonts list showing only those fonts which are
currently active.

You can use the “ P ro bl e m s ” buttons at the bottom
of each area to get the entire lists of just the offend-
ing elements.

The Views palette can also be collapsed to allow
you to view just the categories you want to see
on the palette. Click an expansion arrow on the
right side of the palette to reduce each area to a
simple title line.When you want to expand the
area, click the expansion ar row once again.
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FlightCheck Tip:
Hold down the control key when
clicking an expansion arrow to
open or close all views.



FlightCheck Report

Printing a Report
After a document has been scanned and the Main window is active,
S e l e c t “Print Report... ” from the File menu and the Report prefer-
ences window will appear.

Choose the items
you would like
to include in yo u r
re p o rt by checking
the a p p ro p ri a t e
b oxe s . For colors ,
fonts and images
you can also select
which particular
“ v i ew ” f rom the

pop-up menus that you would like to use for the re p o rt .

Upon clicking the Print button, you can then choose to print in color
( p ro blem items will print in re d ) , as well as choose the font for the Rep o rt .

Detailed Usage
Check the Detailed Usag e box to include the attribute icons in the
printout.

Include Legends
Check the Include Le gends box to print the legends (explanations) for
the attribute icons.

Saving a Report
To save the Report to a text file, which allows you to then import the
text file into an editor, select “Save Report... ” from the File menu.
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FlightCheck Tip:
Select the “Station Name” check-
box to include your computer’s
Chooser name in the Report.

FlightCheck Tip:
With FlightCheck Main Window
Active, select “Print Report”; press
Print button to obtain printer dia-
log box. Hold down the “General”
popup, then select “FLIGHTCHECK.”
Check the “Print Color” button to
print report in color.



Style Sheets and H&J’s
The document’s Style Sheets and H&Js can be viewed by selecting
“Show Styles/H&Js... ” from the Views menu.

This window will display the lists
of Style Sheets as well as a list of
H & J s. You can doubl e-click any
item on either list to view more
specific details about a specific Style
Sheet or H&J.

Unused Style Sheets
Style Sheets marked with an “ * ” a s t e ri s k will signify they are not being
used in the document and will be displayed in red if they re f e rence a font
which is missing.This is important to know because an unused Style Sheet
should not really be considered an “ e rro r ” simply because it will not affect
p ri n t i n g . On the other hand, if you we re to open such a document, i t s
application would be forced to alert you that the font is missing. In this
c a s e, a good preflighter will want to re t u rn to the application and delete
the unused Style Sheets.

Typographic Preferences
To view the Ty p ographic pre f e rences for a QuarkXPress document, s e l e c t
“Show Typo g raphic Preferences... ” from the Views menu.A window
will appear and display the various parameters that have been applied to
the document such as the values for Supers c ri p t , S u b s c ri p t ,A u t o m a t i c
Leading, and so on.
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FlightCheck Help
There are three types of help in FlightCheck: FlightCheck® Help,
General Help and TrueFile™ Solutions (see page 8).

Select “FlightCheck ® Help... ” from the Help menu.The Help window
is sorted by topic and you can click through each section on the left to
find the help you need.

To obtain Hot Help for the Main window or the Ground Controls window
p ress command+? (or select “General Help . . . ” f rom the Help menu) and
a special help cursor will appear. Move the help cursor over an item and
a special Help message window for that item will be displayed explaining
the item.To abort , simply click the mouse button.

FlightCheck Time
Hold down the shift key while clicking the Main
w i n d ow ’s title to obtain the amount of t i m e s p e n t
checking the current document.

Main Window & Ground Controls Title
Hold down the control key while clicking the Main window’s title to
include the name of the current Ground Controls set.
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FlightCheck Tip:
Click and hold down the mouse
button on any item of the Main
window or the Ground Controls
window to obtain the Hot Help.



Ground Controls
The ve ry heart of FlightCheck is based upon a powerful feature called
the “ G round Contro l s ” .These are custom pre f e rences that serve as the ru l e s
for how FlightCheck should conduct its examination and determine exactly
what constitutes an “error”.You can instruct FlightCheck to report on
specific items from several different categori e s , a l l owing you to expand
your document checking possibilities as you desire.

Ground Controls Categories
The Ground Controls are divided into 8 general categories which allows
you to sweep through the flightchecking process section by section.
Select “Show Ground Controls ” from the FlightCheck® menu, or press
c o m m a n d + G, and the Ground Controls window will appear. Click on any
of the category buttons to expand the window into that category.

Reclick the category button to collapse
the window.

Click the expansion ar row on the right side of the window to view the
sub-sections of the category, or reclick to collapse the category.

Controls Lock

At the upper left corner is the Controls Lock. When this icon is
shown in the “locked” state, it means you cannot change any settings.

To unlock or relock the Controls, simply click on the icon.
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FlightCheck Tip:
Clicking a button with the control
key held down will position the
window at the bottom of the screen.



Selecting a Control

To select or deselect a contro l , simply click on the checkbox .

I c o n M e a n i n g

An unchecked box informs FlightCheck to ignore this item.

A checked box informs FlightCheck to use this item duri n g
its inve s t i g a t i o n s .

A black framed unchecked box means the item was found to
be used by the document and could therefore be a possible
item you might want FlightCheck to eventually ve ri f y. S i m p l y
check the box to do so.A good preflighter should alway s v i s u a l l y
inspect the Ground Controls for these framed boxe s .

A red framed checked box will signify FlightCheck has detected
some sort of pro bl e m . Uncheck this box to inform FlightCheck
to assume the item in question is no longer a “ p ro bl e m ” .

The Default Set
FlightCheck always keeps an internal set called the “Default ” set. It is
important to note that all Ground Controls sets (or file sets) share this
D e fault set and for this reason it is recommended you always create yo u r
own custom sets to achieve more flexibility.

Ground Controls Sets
You can create your own customized sets of Ground Controls by selecting
“New Set… ” from the pop-up menu and entering a name.

The currently selected
set will have a check-
mark next to its name
on the menu.

Selecting a Set
To activate a particular set, simply select it from the
m e nu . FlightCheck will then re-examine the document
and report its findings based upon the new settings.
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FlightCheck Tip:
In order to save to a Ground
Controls file you first have to cre-
ate a new set.

FlightCheck Tip:
Changes made to your Ground
Controls settings are always auto-
matically saved when you close
the Ground Controls window.

FlightCheck Tip:
You can undo any changes made
to the current set by simply rese-
lecting it from the menu.



Rename Set
Select this item in order to change the name of the current Ground
Controls set.

Delete Set
Select this item in order to re m ove the current set. Note that if you delete
the “Default” set, FlightCheck will revert to its standard built-in settings.

Ground Controls Files
Ground Controls files are a saved group of Ground Controls sets.These
files can be g iven to your Service Bureau in order to communicate to
them the particular preferences which were used to check the job.

Loading Ground Controls
Use this item to locate and load a previously saved Ground Controls file.

Saving Ground Controls
Select this item (which will only be active when a non-Default set is cur-
rently selected) to save the current group of Ground Controls sets to a file.

Ground Controls Password
Select this item to set or change the passwo rd for the currently loaded
G round Controls file.The passwo rd controls access to the controls lock, a s
well as the rename and delete commands. Note that a passwo rd applies to
a l l sets of the current Ground Contro l s , not just the current set.

Printing Ground Controls
Simply select “P r int Ground Contr o l s … ” f rom the FlightCheck® menu.

Ground Controls Window Title
Click the Ground Controls window ’s title while holding down the contro l
key to toggle showing the actual name of the current set.

The Ground Controls set name will
l i kewise be appended to the Main

window if it has also been set (control-click) for displaying the full titles.
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Application-Specific Ground Controls
You can select which Ground Controls set to use whenever you open a
specific file type.The proper way to do this is by first creating a new set
and then saving the Ground Controls to a file.Then, open a document
and select “Set Application Contr o l s . . . ” f rom the FlightCheck® menu,
or click on the gray application button on the Ground Controls window.

N e x t , select the application’s bu t t o n.

When an application specific set has
been chosen, the application’s icon
will then appear on the Ground
Controls window.

Thereafter, whenever you open a
document created by this application,
the designated Ground Controls set
will be automatically employed to
p e r f o rm the checking, thus elimi-

n a t i n g the need to manual switch Ground Control sets whenever you are
c h e c k i n g various types of documents.
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FlightCheck Tip:
Choose “No Auto-Controls” to
deselect the set from automatically
being used.



The File Category
The File category offers you a way to ensure that the ve rs i o n s
of your application and document do not conflict.The File

category is split into two sections:Application and Document controls.

Application Control
Check the Application box for
FlightCheck to alert you when the
source location of the document’s
application cannot be found.

Document Controls
Check the Ve r sion b ox to ask FlightCheck
to compare the ve rsion of the document
to the selected application’s ve rsion and
to alert you when there is a differe n c e.

Check the L a n g u a g e b ox for FlightCheck to alert you when the language o r
c o u n t ry of the document does not match that of the selected application (as
text may be re f l owed due to differences in hyphenation and justification ru l e s ) .

Check the R e q u i r ed XTensions b ox to be alerted when the document
was created with a QuarkXPress XTension that may be re q u i red to be active
when you later open the document for printing.
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Pages Category
The Pages category allows you to ensure that the docu-
ment’s page size is printable according to the paper

boundaries defined by the document’s Print record.The Pages category
is divided into the Page Size and Paper Size controls.

Page Size Controls
Check either the Width or Height b ox
to be alerted when the page dimensions
are not within the printable area allowe d
by the chosen printer type (PPD) .

Paper Size Controls
Check the Paper Width box to be
alerted when the paper width (a user-
defined value specified within the
a p p l i c a t i o n ’s Page Setup) is greater than
the Print record’s page width.

It the paper width is less than the document’s width, then obviously the
printout will be undesirably “clipped”.
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Page Setup Category
The Page Setup category offers you a way to ensure that
your document’s Page Setup parameters are desirabl e, a n d

is split into the Printer Ty p e, Output and Options contro l s .

Printer Type Controls
Check the P r inter Type b ox to be alert e d
when the P P D file which defines t h e
p rinter type for the document cannot be
located or has been found to contain
some sort of pro bl e m .

Output Controls
Check the Output Resolution b ox
to be alerted when the output re s o l u t i o n
cannot be determ i n e d.

Check the Halftone Scr e e n b ox to
be alerted when the halftone line scre e n
cannot be determined.

You can select the D e fa u l t c h e c k b ox and enter a custom “ ove rri d i n g ”
halftone screen value (in lpi) for FlightCheck to use as a “ t e s t ” w h e n
examining image effective re s o l u t i o n s . Keep in mind that FlightCheck will
be forced to alert you that the Halftone Scre e n va l u e as contained in the
document does not now match the new custom va l u e.

Check the Use Printer Screens (or Use PDF S c r een for QuarkXPre s s
documents) to be alerted when the document has been set to use the line
screen values obtained from the designated printer (or P D F).

Check either the ASCII Data or B i n a r y Data b ox to be alerted when the
output data format has been set for either ASCII or for Binary.

Check the Compatible Gradients b ox to be alerted when this item has
been set in an Illustrator document.

Check the C o n ve r t to Process b ox to be alerted when printing has been
set to conve rt all Spot colors to Pro c e s s .
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Options Controls
Check the Landscape b ox to be alerted
when printing orientation has been set
for Landscape (sideways).

Check either the Reduce or E n l a r g e
b ox to be alerted when a printing scale
factor of Enlargement or Reduction has
been set.

Check the Effects b ox to be alert e d when any Printer Effect has been
chosen including Font Substitution,Text Smoothing, Graphics Smoothing
or Faster Bitmap Pri n t i n g . It is commonly advised that one should alway s
avoid these special printing Effects.

Check the Options b ox to be alerted when any additional Printer Option
has been chosen.This includes Flip Horizontal or Ve rt i c a l ,I nve rt Image,
P recision Bitmap Alignment (4% re d u c t i o n ) , Larger Print A rea and
Unlimited Dow n l o a d a ble Fo n t s .A g a i n , it is widely agreed that all of
the special printing Options should be avo i d e d .

Check either the 2 Up or 4 Up box to be alerted when 2 Up or 4 Up
has been set in the page setup parameters.

Check either the Cover Page Befor e or the Cover Pag e After box
to be alerted when either a Cover Page Before or a Cover Page After has
been selected.
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Print Category
The Print category offers you additional ways to ensure
that your document’s Print parameters are desirable, and

includes Output, S e p a r a t i o n ,S p re a d s ,R e gi s t r a t i o n ,B l e e d ,S e q u e n c e,T i l i n g
and Options controls.

Output Controls
Check the desired box or boxes for
FlightCheck to alert you when an item
has been selected. For example, if yo u
d e s i re the Output to always be N o rm a l ,
then check both the L ow and Rough
output boxe s .

Separation Controls
Check either box to be alerted when
S e p a r a t i o n s has been set or not. A l l
too often one might turn off separa-
tions when printing a quick grayscale
in-house LaserWriter proof, but forget
to turn Separations On when going for
a final print.

Spreads Controls
Check either box to be alerted when
Spreads has been set or not. If you
intend to print spreads during final out-
put, but have turned them off in order
to print each page individually on a
L a s e r W ri t e r, then you can check this
box to instruct FlightCheck to catch
this for you.
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Registration Controls
Check the desired box or boxes for
FlightCheck to alert you when an item
has been selected. For example, if you
intend to print registration marks then
you will want to only check the Off
b ox and leave the other two boxe s
u n c h e c ke d . If you are n ’t going to pri n t
registration marks then you should
check both Center and Off Center .

Bleed Control
Check the Bleed box if you want
FlightCheck to alert you when any object
does not extend sufficiently off the edge
off the page (to compensate for misreg-
istration when cutting the paper).

Sequence Controls
Check the desired box or boxes to be
alerted when an item has been selected.
For example, if you intend to print All
pages of the document then you should
check both Odd and Even .
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Tiling Controls
Check the desired box or boxes for
FlightCheck to alert you when an item
has been selected. For example, if you
do not intend to print Tiling , then you
should check both Manual and Auto .

Options Controls
Check the Thumbnails box to be
alerted when thumbnails has been set.
For example, if you have printed the
document using thumbnails, select this
c h e c k b ox to prevent the document fro m
going out for final printing in this state.

Check the Collate box to be alerted when Collate has been set.

Check the Back to Fr o n t b ox to be alerted when Back to Front has been set.

Check the Include Blank Pages box to be alerted when Include Blank
Pages has been set.

Check the Print Colors as Grays box to be alerted when Print Colors
as Grays has been set.

Check the Black & White box to be alerted when Black & White
printing has been set.

Check the Color box to be alerted when Color printing has been set.
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Colors Category
The Colors category offers you additional ways to
ensure that the colors used in your documents and its

placed images are desirable.

Usage Controls
Check the N o n - C M Y K / Pa n t o n e ® b ox
for FlightCheck to alert you when the
color model for any color is neither
CMYK nor a Pantone.You will probably
want to avoid colors which have been
defined using some other model, s u c h
as RG B, or colors which do not have
corresponding inks available.

Check the Unused Spot box to be alerted when there are unused spot
colors referenced in the document.

Check the Non-Default Trap box for FlightCheck to alert you when
any color has a user-defined default trapping value.

Check the Bitmap Frames b ox to be alerted when any box is using a custom
Bitmap Frame or Bord e r. Bitmap frames and bord e rs usually print at low
quality and should instead be created using actual Po s t S c ript commands or
by using an EPSF i m a g e.

Check the Mismatched Colors b ox to be alerted when the C M Y K va l u e s
of a color referenced in an EPSF image do not match the CMYK values of
a similarly named color specified within the document or application’s
color palette.

Check the Blends box for FlightCheck to alert you when any color is
being used in a blend or a gradient.

Check the Hairlines box to be alerted when hairlines (frames, lines or
paragraph rules) are being used in the document. FlightCheck defines a
hairline as any linewidth less than .25 of one point.

Check the Sum Greater Than nnn% b ox to be alerted for the special
condition when the sum of the CMYK color values exceeds the entered
p e rcentage va l u e. For example, a Black defined as 100% Cya n , 1 0 0 %
M a g e n t a , 100% Ye l l ow and 100% Black adds up to 400% and may in fa c t
yield a muddy brown due to the excessive amount of inks re q u i re d .
Instead, the color should be simply defined as 100% Black ink.
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Trapping Category
The Trapping category offers you a way to ensure that
your document’s trapping values are desirable and is split

into Text, Background and Frame controls.

Text Controls
Check any of the Te x t trapping boxe s
for FlightCheck to alert you when the
document has been set for trapping text
characters.

Background Controls
Check any of the Backg round trap-
ping boxes for FlightCheck to alert you
when an object on the document page
has been set for background trapping.

Frame/Line Controls
Check any of the F r a m e t r a p p i n g
boxes for FlightCheck to alert you
when an object’s frame or border has
been set for trapping.
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Fonts Category
The Fonts category offers you a way to ensure that the
fonts used in your document are desirabl e, and is div i d e d

into Status,Type and Usage contro l s .

Status Controls
Check the A c t i ve b ox for FlightCheck
to alert you when any font the docu-
ment is using is not currently active in
your System.

Check the S c r een F o n t b ox to be alerted when any Screen Font the
document is using cannot be located, meaning the font is neither active in
the System nor can FlightCheck find the named font in the Fonts Database.

Check the P r inter F o n t b ox for FlightCheck to alert you when any Pri n t e r
Font file cannot be located.A missing printer font file will always force
the printer to substitute the font with some default font (usually C o u ri e r ) .

Note that not all fonts re q u i re a companion printer font file and some fonts
(such as Tru e Ty p e®) have built-in printer instructions on how to draw the
characters.

Type Controls
Check the Tr u e Ty p e ™ b ox for
FlightCheck to alert you when any
font is of the type Tru e Ty p e. Some out-
put devices are incapable of handling
TrueType fonts, and furthermore it is

a generally accepted fact that mixing fonts on a page (using Type 1 and
TrueType) can cause some unexpected output problems.

Check the City/System Font box for FlightCheck to alert you when
a ny font has a name that is associated with a city, such as Chicago, G e n eva,
Monaco, Charcoal, etc.The reason for this is that most “city” or System
fonts are usually merely bitmap fonts and always print at a fairly low
quality, thus they should be avoided.

Check the Multiple Master s box for FlightCheck to alert you when
any font is of the type Multiple Masters.
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Check the Non-Adobe ® box to be alerted when any font is not an o f f i-
cial Adobe font.With all due respect for other font manu fa c t u re rs ,m a ny of
whom create very high quality and fine-looking fonts, it is sometimes
decided by certain designers to commit to all Adobe fonts to ensure out-
put compatibility. It is a known fact that mixing different types of fonts
on a page can lead to unwanted output pro bl e m s .These kinds of issues
can be avoided if a policy is set for the workflow that a document should
always be created using only known versions of Adobe fonts (or for that
matter, any one manufacturer’s fonts) which per the licensing agreement
the Service Bureau will likewise own and there f o re the expected output
will be predictably safe.

Usage Controls
Check the Menu Styled box for
FlightCheck to alert you when any font
has been stylized via the application’s
Style menu and the font contains no
e q u ivalent built-in style.This pro bl e m

exists rather frequently. For example, if you select some text and choose
“Bold” from the Style menu, but the font itself is incapable of printing in
boldface, then even though the text appears bold on the screen, it will be
printed as plain text on paper.Additionally, if the font can indeed support
the style, its companion printer font file must also exist in order to achieve
the desired style during printing.Therefore, FlightCheck will warn you if
either the font cannot support the style, or the printer font cannot be found.

Check the E n c o d i n g b ox for FlightCheck to alert you when any font
uses a Non-Standard Encoding. Not all printing devices are capable of
p rinting all characters in a set and there f o re certain characters may need
to be “ re m a p p e d ” .This is normally based upon a standard encoding scheme,
which could va ry on different platform s .T h e re f o re, this checkbox can be
used to point out possible output conflicts.
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Images Category
The Images category offers you a way to ensure that the
images placed in your document are desirable and can

be acceptably printed, and is divided into Type, Mode, File Status, Image
Box, Contents and Resolution controls.

Type Controls
Check the desired picture Type boxes
for FlightCheck to alert you when any
image is of that type. For example, if yo u
do not want to use any JPEG encoded
i m a g e s , then you should check the J P E G

b ox .The item “ O t h e r ” re p resents any
other image type which is not listed.

Mode Controls
Check the desired picture Mode boxes
for which you want to be alerted. For
example, if you do not want any RG B

images,then check the RG B box.

File Status Controls
Check the M i s s i n g b ox for FlightCheck
to alert you when any image file is
missing.This obvious problem often
results in the application sending the
low-resolution preview of the image
to the printer if the ori ginal source file
containing the high-resolution data
cannot be located.

Check the M o d i f i e d b ox to be alerted when any image file’s last modified
date does not match the date of the link data saved within the document.
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Check the Stored box for FlightCheck to alert you when an image is
embedded within your document file. In the case of a PageMaker docu-
ment or an E P S F image which contains an image, the embedded image
aids in guaranteeing the document can be printed,seeing how the image
cannot possibly be considered “missing”. However, new problems could
arise if for some reason the Service Bureau needs to edit the image, they
may have a difficult time extracting the image out of the document file.

Check the Not Included box in order to have FlightCheck alert you
when an E P S F file contains only a pathname re f e rence to another image.
For example, while inside an application such as Illustrator you can place
an image and when saving the document as an E P S F you can elect to
“not include” the placed image.This is acceptable for Illustrator, but if
you then place the E P S F on a QuarkXPress document page, you will not
be able to print the image because the printing device will know nothing
about the file system or how to locate the additional image.

Check the N e s t e d b ox for FlightCheck to alert you when an E P S F i m a g e
contains another image. Similar to the “ s t o re d ” f u n c t i o n , this is not alway s
c o n s i d e red a real pro bl e m , other than it is sometimes impossible to be abl e
to extract and edit the embedded image, but the potential pro blems do in
fact exist.This is compounded by the fact that when an image within a n
image gets into multiple laye rs (called “ p l y s ” ) ,p rocessing time incre a s e s , a n d
in extreme cases can cause the output device to bog down or run out of
m e m o ry (similar to pro blems encountered when “ gro u p i n g ” too many objects).

Encoding Controls
Check either the ASCII or the B i n a r y b ox to be alerted when an image
has its pixel data encoded with type.

Check either the L Z W or J P E G boxes if you want to be alerted if any
image has been compressed as L Z W or J P E G.While most output devices
can support L Z W compression, some cannot support J P E G.
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Image Box Controls
Check the S u p p re s s e d (also called “ N o n -
P rinting”) box to be alerted when any
image or picture box has been suppre s s e d
from printing.

Check the Off the P a g e b ox to be alert e d
when any image is outside the printable
a rea of the page (or is on the pasteboard ) .

You can use the Fill “ N o n e ” pop-up menu to select which specific images
you want checked by FlightCheck that reside in picture boxes containing
a background fill of the special transparency color “None”. Note that an
u n d e r l i n e d image type on the pop-up menu indicates the particular image
type is in fact used within the document.

Check the C o l o r ed Fill b ox to be alerted when a gr ayscale image re s i d e s
in a box which uses a colored background or fill.

Check the Clipping P a t h b ox to be alerted when any pixel-based image
resides in a picture box having a background set to “ N o n e ” and there f o re
m ay re q u i re a clipping path to achieve optimum output.Vector-based EPSF

images will always be excluded from this determ i n a t i o n .

Check the Bitmap Frame b ox for FlightCheck to alert you when any
image resides in a picture box which has a custom Bitmap Frame or Bord e r.
Most custom bitmaps print at an unacceptably low quality.

Check either the B ox Rotation or B ox Skew b oxes to be alerted when
a picture box has been rotated or skewed

Contents Controls
Check either the I m a g e Scale , I m a g e
Rotation or Image Sk ew boxes if you
want to be alerted when any image has
been scaled, rotated or skewed. Scaling
is by far the more serious picture attri bu t e
to contend with. Rotation and skew can
alter the way an image “looks”, and the
only real drawback is added processing

time, but scaling becomes an extremely critical factor in determining the
output quality of an image. It is therefore far better to return the image
back to the application which created it and change its resolution or to
modify the image in such a way so that it can be placed on the document
page at 100% scale with no further rotation or skew applied.
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Check the H/V Flip box to be alerted when the contents of a picture
box has been flipped horizontally or vertically. Flipping by itself may not
constitute a real er ror, other than adding processing time, unless of course
the box has its contents flipped by mistake, in which you will be happy
to have FlightCheck point this out.

Check the S t y l e s / C o n t r a s t b ox to be alerted when any image has had a
Style or Contrast applied to it. Sometimes when a 1-Bit image which has b e e n
“ c o l o ri z e d ” , or has had some sort of contrast applied, is sent to c e rt a i n p ri n t e rs ,
the color information might be ignore d , especially if OPI ( h i - res image
substitution) is employe d . In this case, it is better to re t u rn t o the application
which created the image and to apply the desired color to the source image.

Check the P i c t u r e Tr a p b ox to alert when a picture has been set for trapping.

Check either the Halftone Screen or Transfer Function boxes to be
alerted when an image contains either a Halftone Screen or a non-linear
Transfer Function.The reason why you would want to know about these
special functions is because these built-in routines are essentially Po s t S c ri p t
commands that will alter the pixel data as it is being sent to the printer,
with the end result possibly being a printout you do not expect.

Check the C h a n n e l s b ox to be alerted when any image contains additional
channels. Most applications will safely ignore the additional channels of
an image, but a native Photoshop file which uses additional channels will
stop most RIPs.

Check the Layer s box to be alerted when any image contains additional
c h a n n e l s . Because most RIPs cannot handle a laye red image, it is there f o re
recommened one should resave the image in a “flattened” state.
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Resolution Controls
Check the R e s o l u t i o n b ox to be alert e d
when the effective resolution for any
image is not within the specified range
(as entered into the Minimum and
Maximum edit boxes).We use the term
“effective” because the final resolution
of an image has to take into account
any scaling applied to the image.

This is a ve ry critical and extremely important function of FlightCheck.
W h e n ever FlightCheck scans an image, it then compares the image re s o l u-
t i o n to the output line screen and will post an error if the effective
resolution does not fall within the desired range. It is commonly accept-
ed that the effective resolution of an image should be between 1.5 to
2.0 times the line screen in order for the output to be acceptable. For
example, if the line screen is 150 lpi (lines per inch) and you enter a
maximum effective resolution value of 2.0, then any image which has a
dpi (dots per inch) greater than 300 (in other words 2.0 times 150)
would be considered an “error”.

The Factor/DPI pop-up menu allows you to choose between specify-
ing the effective resolution range in terms of a factor, such as 1.5 to 2.0,
or an actual DPI. For example, if the line screen is 150 lpi, and you still
want the range to be 1.5 to 2.0, you can enter DPI values of 225 to 300
(1.5 times 150 and 2.0 times 150) into the Minimum and Maximum edit
boxes to achieve the same effect as you would by selecting Factor.

Check the B i t m a p s b ox to be alerted when the effective resolution for any
1-BIT image is not within the specified range. Because 1-BIT images are
p rinted using single black or white dots and can be mapped easily into any
spatial are a , the Minmum and Maximum values can be much greater than
c o l o re d , mu l t i - p i xel images.

Check the F l a t n e s s b ox to be alerted when the flatness value for any image
is not within the specified range.“ F l a t n e s s ” is the accuracy (or smoothness)
with which curves are to be re n d e red on the output dev i c e.The value give s
the maximum tolerance for calculating a curve, m e a s u red in output dev i c e
p i xe l s . Smaller nu m b e rs give smoother curve s , but at the expense of more
computation time and memory usage.You can enter Minmum and
M a x i mum values in order for FlightCheck to alert you when an image con-
tains a flatness setting that falls outside the desired range.
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Problems Layout
FlightCheck offers a powerful feature called the “ P ro blems Layo u t ”w h e re by
you can view the layout of the document’s pages in order to discover the
locations of offending objects. Select “S h o w Problems Lay o u t . . . ” f ro m
the V i ews menu , or type command+L.

The list of problem colors,fonts and images for the selected page will
appear on the left side of the window.At the bottom left you can either
enter a specific page number to view, or you can click the “page” icons
to thumb through the document.

Show Items
In the center of the window will be a miniature display of the offending
objects on the chosen page and this will depend on which S h o w Items h ave
been selected at the bottom of the window. Select the desired checkboxe s
to view specific pro blem objects.

Items List
The Items list on the right side of the window will display a list of the
p ro blem boxe s . Clicking an item will highlight the re s p e c t ive object
within the page prev i ew. D o u ble-clicking an item will bring up the Box
Info window.
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Select the “Section Format”
checkbox to be able to enter page
numbers based on their format.

FlightCheck Tip:
Hold down the control key while
clicking a checkbox to deselect all
others.



Box Info
Note that you can also click an image
name on the Images list over on the
left side of the window to highlight its
object, or you can simply double-click
the image name to display the box info.

Print Layout
Click the Print button to print out the diagram and/or a listing of the
page’s problems.This printout can then be used as a reference when you
return the document to its application to correct the problems.

Go to Problem
When an object has been selected
on the Items list, click the “Go
To Problem ” button to launch
the document’s application in
order to be taken directly to the
problem page and box.

The pro blem box will be conve n i e n t l y
selected on the document page allowing
you to quickly edit or correct the pro bl e m.

58

FLIGHTCHECK



Custom Forms
FlightCheck offers you a va l u a ble feature of allowing you to create custom
f o rm s . M a ny Service Bureaus re q u i re a form to be filled out that descri b e s
the job and FlightCheck makes doing this work a lot easier for yo u .To
c reate a custom form select “N ew Fo rm . . . ” f rom the Fo rms menu , or press
command+N, and a Form window will appear. (Note that you can bring
the Fo rm window in front of all other windows by pressing command+R).

Form Template
After your Form is complete and you select “Save Form... ” from the
File menu, you can check the Template box and the Form will be saved
as a Template (all fields will be cleared when later opening this Form).

Place EPSF
FlightCheck allows you to place a preview of an existing E P S F image on
the window thereby allowing you to set your typing fields in the appro-
priate positions. Select “Place E P S F ... ” from the Forms menu, or type
c o m m a n d + E , and locate the desired file. Note that you can move a placed
E P S F by holding down the option and command keys, then clicking on
and dragging the picture to the desired location. Select “Undo Mo ve”
from the Edit menu if you change your mind.

When printing a form, you will be offered a checkbox where you can
elect to omit the placed E P S F from printing which will allow you to use
your preprinted forms.

Tools Palette
The Tools palette offers you several items you can use to edit your Form.

Icon Meaning

The a r row tool can be used to select specific fields.You can hold
d own the shift key to select multiple fields, or click and drag the
a rrow cursor to surround a group of fields to select them. Once a
field has become selected, as evidenced by it being highlighted on
the scre e n , you can then perform va rious operations on the field,
such as Cut,A l i g n , and so fort h .

The ASCII or t e x t tool can be used to create new editing fields.

You click and drag to create a new field, its height depending on
the currently selected font and point size.
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Icon Meaning

The va ri a ble field tool can also be used to create new editing
f i e l d s .You click and drag to make a new field of any size. N o t e
that you can obtain this tool at any time by holding down the
option key.

The h a n d tool can be used to move fields.

Creating a New Field
Select either the A S C I I or variable field tool, then simply click and drag
to size the new field.

Resizing a Field
Select either the A S C I I or variable field tool and when the cursor hovers
over the bottom right corner of the rectangle, click and drag the corner
to resize the field.

Deleting a Field
Select the arrow tool, click on the desired field to highlight it, then either
hit the delete key, or select “ C u t ” f rom the Edit menu . If you change
your mind you can select “Undo Delete Field” or, in the case of a Cut,
you should select “Paste” from the Edit menu.

Align Felds
Select the arrow tool, click on the desired field, or hold down the shift
key to click and select multiple fields, or click and drag to surround and
select a group of fields, then choose the desired Align type on the Fo rm s
m e nu . If you change your mind, you can select “Undo Align Fields” f ro m
the Edit menu.

Text Font, Point Size, Style and Alignment
Using the A S C I I tool, select the text characters you wish to edit, then
choose the desired parameters from the Fo rms menu to change the font,
point size, style or text alignment. Note that if no field is active at the
time, the text attributes selected will become the default parameters to
be applied to newly created fields.
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Insert List
Using the A S C I I tool, click within the field in which you would like to
i n s e rt a list, then choose the desired list item from the I n s e r t List p o p - u p
menu.The data for the selected list item will be inserted into the current
field at the blinking cursor position using the current font and point size.

Checking the “Tab Delimited” menu item will cause the inserted data to
be separated by tabs instead of carriage returns.

Custom Form Templates
When creating a custom form template you can use “Insert Field” to
c reate a special “ m a gic field” so that whenever you check a document,
and then open the template form, the designated fields will be automati-
cally updated. For example, if you create a field and select “ Fo n t s ” f ro m
the Insert Field pop-up menu and save the custom form as a template,
then in the future when you check a document you can find and open
your custom template form and the field will be automatically filled in
for you with the list of the document’s fonts.

Insert Page, Move to Page and Remove Page
You can inser t a page into your Form, go to a specific page, or remo ve
the current page from the Form by selecting the appropriate item on the
Forms menu.
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Collecting the Job

Collect Job
“ C o l l e c t i n g ” means to gather up all of the files related to a particular job,
including the font files, images and the document file itself, and copying these
files into a single job folder. FlightCheck allows you to collect all elements i n
a job to pre p a re the job for output or further production wo r k .

Select “Collect Job... ” from the Collect menu, or press command+J,
and the Collect Job window will appear.

Collecting Fonts
The fonts list at the bottom left side of the window will show the status of
each font (which will be the same as the icons displayed on the Main window ) .

To set a font to be collected, click in the screen font column and a
checkmark will denote the font has been chosen.

To select the printer font file, click in the printer font column.

Note that a red font name will indicate the font file is missing.

Styles Menu / Point Size Menu
You can select either “All Styles ” f rom the Styles pop-up menu to include
the styles found within the font, or “Used Styles ” to collect just the specific
styles used within the text of the document.
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You can similarly select “A l l ” f rom the Point Size pop-up menu to
include sizes of the font, or you can choose a single size of 9, 10 or 12.
Selecting the Used Style and single point size can often reduce the size o f
the final collected job. However, always check with your Service Bureau
to learn exactly how they would like to accept your font files.

Fonts Folder
If you wish to collect the fonts into a separate fonts folder, select the
Fonts Folder checkbox.

Single Suitcase
If you wish to merge all fonts into a single suitcase file, check the S i n g l e
S u i t c a s e b ox .The resulting suitcase file will be conveniently entitled
“documentname.fonts”.

Collecting Images
The images list at the bottom right side of the window will show the
status of each image.To set an image to be collected, click in the 
image column and a checkmark will denote the image has been chosen.

Note that a red image name indicates the file is missing.

Selecting Image Types
You can conveniently deselect all images by single-
clicking the image column header icon. Clicking
the icon a second time will reselect all images.

You can also obtain additional selective control by
holding down the mouse button on the image col-
umn header icon in which case a pop-up menu will
appear allowing you to choose the specific types of
images you would like to collect.

Note that an underlined image type on the pop-up
m e nu indicates the particular image type is in fact used
within the document.
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Full Image Pathnames
Click on the Images column header “Name”in order to display the list
of images using their full pathnames.

Images Folders
If you wish to collect the images into a separate folder, check the I m a ge s
Folder box. Select the Extract Images button to create new image files
using the images stored in the publication and the OPI F o l d e r s to collect
hi-res and lo-res images into separate folders.

Collecting Ground Controls
Select the Ground Controls checkbox in order to include the current
Ground Controls file with your job. Note that the resulting file will have
its password removed, and each set will be conveniently locked (although
sets can be easily unlocked).The reason for this is so that you can safely
pass along your Ground Controls file to a print shop or Service Bure a u
without having to give them your secret password.

Include Files
You may want to include additional files related to your document by
checking the desired items in the Include Files area of the Collect window.
You should, of cours e, select at least the Document checkbox to include the
actual document file in the collected job. For QuarkXPress documents, yo u
m ay want to check the XPress Pre f s ,R e q u i red XTensions box (when enabl e d )
and Dictionary boxes to include them in your collected job.

Misc. Files
Check the Misc. Files box in order to collect any additional files yo u
would like to include.A window allowing you to locate and create a list
of extra files will then be offered when the collection process begi n s .

Job Information
At the top right on the Collect window is the Job Info, including the
total number of files selected and the estimated accumulated file size of
the job (before compression) which you can then compare to the Space
Available value over at the top left side of the window (a red value will
indicate insufficient disk space).
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Compress Job
Check the C o m p r ess J o b and S e l f - E x t r a c t i n g b oxes as desired in ord e r
to compress all of the files of the job into a single compacted file.You may
also choose to save the job as B i n H e x or to S eg m e n t to multiple disks.

Retain Job Name
Select the Retain Job Name checkbox in order to save the current title
for the job.This allows you to merge multiple jobs into this same job folder
during subsequent collections.

Creating a Job Folder
When all of the selections for your job
have been made, type in a name for the
job folder, locate the desired destination
on your drive, then click the Collect
button. If a folder already exists for the
job, you will be prompted in order to

continue with the collection.

Select the Use existing folder button to merge the current job into the
folder or use the Au t o - r ename new folder button to create a new folder.

Final Job Folder
The resulting job folder will display a special FlightCheck seal of approva l
icon if the collection has passed inspection, or a fa i l u re icon if t h e re wa s
some pro blem with collecting the entire job.

Pass Folder Fail Folder
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Collect Report
To create a text re p o rt of all the elements comprising the job, s e l e c t
“Collect Repor t . . . ” f rom the Collect menu . Similar to the Collect for
Output Re p o rt within Qu a r k X P re s s , the resulting text file can then be
placed within a wo rd processor or editor.

You can choose to include in your re p o rt
i n f o rmation re g a rding specific categori e s o f
elements by checking the appro p ri a t e b oxe s .

N avigate to the location where you wa n t
to save the file, enter a title for the Re p o rt ,
then click the S a ve bu t t o n .

Stuff / Unstuff
You can also compress files by selecting “S t u f f … ” f rom the Collect menu .

Select a file and click the Add button to add the file to the Files List.To
remove a file, select it on the Files
List and click the Remove button.

You can choose to make the re s u l ti n g
c o m p ressed file S e l f - E x t r a c t i n g , or a
B i n H e x file (suitable for e-mailing), by
selecting the appro p riate checkboxe s .

To decompress a previously stuffed
file, select “Unstuff... ” from the
Collect menu.

Segment / Join
To individually compress large files you can select “S eg m e n t … ” f rom the
Collect menu . Choose the type of disk (or enter a default disk size) from
the Size of Segments pop-up menu, locate the a rc h ive, then press the
Segment button and follow the directions for inserting disks.

To join a previously segmented file, select “Jo i n . . . ” f rom the Collect menu ,
locate the archives and follow the directions for inserting the disks.
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FlightScript™

Applescript Functions
FlightCheck provides several scripting functions which you can access via
AppleScript®.While the subject of scripting itself is beyond the scope of
this manu a l , the examples given below can be used to build your scri p t s :

Obtaining a List
Executing the following script will return a list of colors:

tell application “FlightCheck”

activate

get colorlist

end tell

Getting the Current View
Executing the following script will return the current view for fonts:

tell application “FlightCheck”

activate

get font view

end tell

Getting the Number of Problems
Executing the following script will return the number of problem images
(using the currently selected view):

tell application “FlightCheck”

activate

get image problems

end tell
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Conditional Scripts
Executing the following conditional script will return a list of colors
only if the cur rent view is “Spot Colors”,set the current font view to All
Fonts only if there are font problems, and will return a list of images only
if there are image problems:

tell application “ F l i g h t C h e c k ”

a c t iva t e

if (get color view) = (“Spot Colors”) then get color list

if (get font pro blems) > 0 then set font view to All Fo n t s

if (get image pro blems) > 0 then get image list

end tell

Scripting Functions
The list of possible scripting commands is as follows:

COMMAND RESULT

flightcheck “file name” FlightCheck named file

get color list returns a list of colors

get font list returns a list of fonts

get image list returns a list of images by full pathname

get image names list returns a list of images

get RG B images returns a list of RG B images

set color view to ____ sets the view for colors

Used Colors

All Colors

Spot Colors

Process Colors

Trapped Colors

Unused Colors

Mismatched Colors

Problem Colors
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set font view to ____ sets the view for fonts

All Fonts

Active Fonts

Database Fonts

Missing Fonts

Missing PS Fonts

Menu Styled

Problem Fonts

set image view to ____ sets the view for images

All Images

Missing Images

Modified Images

Unused Images

Stored Images

Bad Resolution

O P I Images

RG B Images

Compressed

Fill “None”

Stylized Images

Bitmap Frames

Problem Images

get color view returns the view for colors

get font view returns the view for fonts

get image view returns the view for images
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load “controls name” loads named Ground Controls file

select set “set name” selects named Ground Controls set

get ground controls title returns name of Ground Controls

do full flightcheck recheck file

get flightcheck results returns the list of results

print results prints the results

show specific items opens specific items

show general items closes specific items

print report prints a FlightCheck report

save report saves a FlightCheck report

save report “report name” saves a FlightCheck report to file name

collect report saves a collect report

collect report “report name” save a collect report to file name

collect job collects the job

collect job “job name” collects job to folder name

get document title returns document name

get application info returns application info

get file info returns file info

get page info returns page info

get page setup info returns page setup info

get printer info returns printer info

get trap info returns trap info

open form “form name” opens named custom form

print form prints the current form

close form closes the current form
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Scripting a Workflow
You can use the following list of AppleScript commands which you can
send to FlightCheck in order to create a workflow that can automatically
check documents and obtain the results.

Note that lines beginning with “–” dashes are commented out. Simply
remove the dashes at your discretion before running the script:

tell application “FlightCheck”

–activate

with timeout of 120 seconds --IN CASE OF LARGE FILE

--flightcheck “my drive:my folder:my document file”

--end timeout

–GET A FILE VIA AN OPEN DIALOG:

–set theFile to choose file

–flightcheck theFile

–load “my drive:my folder:my ground controls file”

–select set “my set”

–do full flightcheck

–get flightcheck results

–print report

–save report

–save report “my report”

–collect report

–collect report “my report”

–collect job

–collect job “my job”

–open form “my drive:my folder:my form file”

–print form

–close form

–quit application “FlightCheck” saving no

end tell
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